
 

 



CLASS – X 

ENGLISH 

1. Ek Bharat Shreshtha Bharat (EBSB) - Tourism Advertisement Script 

 Write a 1-minute advertisement script promoting Sikkim.  

 Include:  

o Catchy slogan  

o Key attractions (waterfalls, temples, culture etc)  

o Emotional appeal 

2. MULTILINGUISM- A. “Common Phrases in Kannada” 

Write daily use English sentences and translate them into Rajasthan’s language on an A-4 

sheet. 

3. ART INTEGRATED–  

Design a creative poster on “Save Tigers”. 
4. BOOK REVIEW- 

 Choose any two books and write the book review in 120-150 words in the given format.  

     1. The Author          2. The Content           3. Theme           4. Your favourite character 

5. Attempt the following questions in English Notebook. 
I. You are Riya Sharma, a resident of Rohini, New Delhi. Write a letter to the Municipal Commissioner 

complaining about the poor sanitation and overflowing garbage in your locality. Suggest suitable measures 

to improve the condition. 

II. Fill in the blank with a suitable determiner: 

There is __________ water left in the bottle. 

a) many  b) little  c) few  d) several 

III. Fill in the blank with a suitable determiner: 

__________ student in the class participated in the science exhibition. 

a) Each  b) Much  c) Few  d) Little 

IV. Fill in the blank with a suitable determiner:  

We did not receive __________ reply to our invitation. 

a) any  b) many  c) several  d) every 

V. Choose the correct determiner: 

She has visited the museum __________ (every/ several) times this year. 

VI. Identify the error and write the correction: 

There are much books on the table. 

 

ERROR CORRECTION 

  

 

6. WORDS & EXPRESSIONS BOOK –  

DO UNIT 3 AND 4 IN THE BOOK. 

 



HINDI 

1. निम्ननिखित पाठ ों क  ध्यािपूर्वक पऩिए एर्ों प्रते्यक पाठ का माइोंड मैप तैयार करें  – 

 बडे भाई साहब  

 डायरी का एक पन्ना  

 ततााँरा-र्ामीर  कथा 

2. “बुरा ज  देिि मैं चिा…” सािी का भार्ाथव निखिए।  

3. कबीरदास के अिुसार मिुष्य क  नकस प्रकार का व्यर्हार करिा चानहए?  

4. साखिय ों में कौि-कौि से जीर्ि मूल्य बताए गए हैं?  

5. कबीरदास की भाषा-शैिी की नर्शेषताएाँ  निखिए।  

6. अपिी पसोंद की नकसी एक सािी क  सुोंदर िेिि में नििकर उसका अथव निखिए। 

7. मीरा के पद ों में भखि भार्िा कैसे प्रकट हुई है?  

8. “मेरे त  नगरधर ग पाि…” पद का भार् निखिए।  

9.  ट पी शुक्ला और इफ़्फ़ि की नमत्रता समाज क  क्या सोंदेश देती है?  

10. पाठ में नदिाए गए सामानजक भेदभार् पर अपिे नर्चार निखिए। 

11. र्तवमाि समाज में आपसी भाईचारे और सौहादव  बिाए रििे के निए क्या प्रयास नकए जािे चानहए?  

12. नर्द्यािय में पुस्तकािय की व्यर्स्था सुधारिे हेतु प्रधािाचायव क  पत्र निखिए   

13. निम्न नर्षय ों पर अिुचे्छद िेिि कीनजए – 

 पयावर्रण सोंरक्षण  

 समय का सदुपय ग 

14. “हररहर काका” पाठ के आधार पर सोंयुि पररर्ार एर्ों एकि पररर्ार की तुििा चाटव के माध्यम से प्रसु्तत 

कीनजए। पाठ के नकसी एक दृश्य का नचत्र बिाकर उसका र्णवि निखिए।    

MATHEMATICS 

 

        Activity: (Co-ordinate Geometry) 

 On a Cartesian plane, locate the following points; 

 Hospital (3, 4) 

School (9, 12) 

 Park (2, -1) 

 Railway Station (-6, 2) 

 Bus stop (2, -4) 

Show their perpendicular distances from each axes using any object like toothpick, matchstick etc. Paste it 

on a thick sheet or cardboard. 

         

       Activity: (Real Numbers) 

 Present the grouping/classification of different types of numbers in a creative manner to show the hierarchy 

of numbers. 

       Case Based Questions 

  



1. To enhance the reading skills of grade X students, the school nominates you and two of your friends to set 

up a class library. There are two sections- section A and section B of grade X. There are 32 students in 

section A and 36 students in section B. 

a) What is the minimum number of books you will acquire for the class library, so that they can be 

distributed equally among students of Section A or Section B? 

b) If the product of two positive integers is equal to the product of their HCF and LCM is true then, find 

the HCF of the number of students in each section. 

c) Express the students in each section as a product of their primes. 

d) If p and q are positive integers such that p = ab2 and q= a2b, where a , b are prime numbers, then find 

the LCM (p, q). 

 

2. An asana is a body posture, originally and still a general term for a sitting meditation pose, and later 

extended in hatha yoga and modern yoga as exercise, to any type of pose or position, adding reclining, 

standing, inverted, twisting, and balancing poses. In the figure, one can observe that poses can be related 

to representation of quadratic polynomial. 

 

 
a) What is the shape of the poses shown? 

b) In the graph, how many zeroes are there for the polynomial? 

 

 
c) Find the two zeroes in the above shown graph. 

d) Find the zeroes of the quadratic polynomial : 

 
3. The class X students school in krishnagar have been allotted a rectangular plot of land for their gardening 

activity. Saplings of Gulmohar are planted on the boundary at a distance of 1 m from each other. There is 

triangular grassy lawn in the plot as shown in the figure. The students are to sow seeds of flowering plants 

on the remaining area of the plot. 

 
 



a) Taking A as origin, find the coordinates of P 

b) What will be the coordinates of R, if C is the origin? 

c) What will be the coordinates of Q, if C is the origin? 

d) Calculate the area of the triangles if A is the origin. 

 

4. Alia and Shagun are friends living on the same street in Patel Nagar. Shagun’s house is at the intersection 

of one street with another street on which there is a library. They both study in the same school and that is 

not far from Shagun's house. Suppose the school is situated at the point O. 

 i.e., the origin, Alia's house is at A. Shagun’s house is at B and library is at C. Based on the above 

information, answer the following questions. 

 

a) How far is Alia's house from Shagun’s house? 

b) How far is the library from Shagun’s house? 

c) Show that for Shagun, school is farther compared to Alia’s house and library. 

d) Show that Alia’s house, shagun’s house and library for an isosceles right triangle. 

 
5. A Mathematics Exhibition is being conducted in your School and one of your friends is making a model 

of a factor tree. He has some difficulty and asks for your help in completing a quiz for the audience. 

Observe the following factor tree and answer the following: 

 

  
 

a) What will be the value of x? 

b) What will be the value of y? 

c) What will be the value of z? 

d) Show the prime factorization of 13915. 

 

SCIENCE 

ACTIVITY 

 Create a timeline showing major environmental changes over the past century (such as deforestation, 

pollution, or climate change) and their impact on society. [ROLL NO. 1- 15] 
 



 Create comic strips that narrate the journey of electricity from generation to household usage, highlighting 

its importance and safety. [ROLL NO. 16 - 32] 

 

PRACTICAL FILE WORK 

Complete the following experiments in Science practical file. 
1. To perform and observe the following reactions: combination, decomposition, displacement and double 

displacement reaction. 

2. Find the pH of the samples by using pH paper. 

Complete the following questions in their respective notebooks 

1. A gardener notices that a plant wilts when its stem is cut near the base. 

a. Which tissue gets damaged due to cutting?  

b. What is the role of this tissue?  

c. Why do leaves wilt after water supply stops? 

  2. Riya eats food rich in carbohydrates but suffers from poor digestion due to lack of enzymes. 

a. Which digestive gland secretes enzymes for carbohydrate digestion?  

b. What will happen if saliva production decreases?  

c. Why is digestion important for the body? 

3. A student accidentally touches a hot iron rod and immediately pulls back the hand. What type of response 

is this? Which part of the nervous system controls it? 

4. A plant bends towards sunlight kept near a window. Name the phenomenon shown. Why does the stem 

bend toward light? 

5. Three bulbs are connected in series. What happens if one bulb fuses? How does current behave in a series 

circuit? Why are series circuits not preferred in homes? 

6. Study the following electric circuit and find (i) the current flowing in the circuit and (ii) the potential 

difference across 10 Ω resistor. 

 
7. Baking soda is used in making cakes soft and fluffy. 

a. What gas is released during heating?  

b. Write the chemical name of baking soda.  

c. Why does the cake rise? 

8. On diluting an acid, it is advised to add acid to water and not water to acid. Explain why it is so advised? 

9. Silver chloride turns grey in sunlight. Which type of reaction is this? Why does the colour change occur?  

10. What is the colour of ferrous sulphate crystals? How does this colour change after heating? 

11. The sky appears blue during daytime. Which phenomenon is responsible? Which colour scatters the 

most?  

12. Why does the sky appear dark to passengers flying at high altitudes? 

SOCIAL SCIENCE 

Part A –Assignment  

Chapters: Development (Economics) & Resources and Development (Geography) 

NOTE: Answer the following questions neatly in your social science notebook: 

I. Very Short Answer Questions 

1. What is development?  

2. Define resource.  

3. What is sustainable development?  



4. Name any two renewable resources.  

5. What is resource planning? 

 

II. Short Answer Questions 

1. Explain the limitations of per capita income as a measure of development.  

2. Differentiate between renewable and non-renewable resources.  

3. Explain the importance of sustainable development.  

4. Describe the classification of resources with examples.  

5. Explain the steps involved in resource planning in India.  

6. Why is conservation of resources important?  

7. Explain any three developmental goals of people.  

8. Describe the role of education and health in development.  

 

III. Long Answer Questions 

1. “Development for one may not be development for another.” Explain with examples.  

2. Explain the problems caused due to overuse of resources.  

3. Describe different types of resources on the basis of ownership and exhaustibility.  

4. Explain the importance of sustainable resource development.  

 

IV. Map Work - Locate and label major soil types on the political map of India.  

 

Part B – CBSE Project Work (Choose Any One Topic) 

Prepare a project file (8–10 pages) on any ONE of the following topics: 

1. Consumer Rights  

2. Social Issues  

3. Sustainable Development  

 

The Project File Should Include: 

 Cover Page  

 Acknowledgement  

 Index  

 Introduction  

 Main Content with headings/subheadings  

 Relevant pictures, newspaper cuttings, charts, diagrams, or survey work  

 Conclusion  

 Bibliography  

 

Instructions: 

 The project may be in PowerPoint Presentation (PPT) or PDF Format. 

 Maintain neat presentation and proper headings.  

 Include creative work such as posters, slogans, surveys, and charts. 

 

                                                         ARTIFICIAL INTELLIGENCE 

Q1.Visit the URL https://www.youtube.com/watch?v=ZYGND_SLqUQ and learn how to properly maintain 

and take care of your computer properly. Then, write five important points on computer maintenance in your 

notebook. 

Q2.Visit the given website https://www.my-goodness.net/ and participate in the activities to explore your 

decision-making skills. Observe how personal morals, values, and ethics influence your choices, then write a 

short reflection on what you learned from activity in your notebook. 

Q3. Short Answer Questions: 

a. What is AI modeling?  



b. Define machine learning model.  

c. What is the difference between supervised and unsupervised learning?  

d. What is training data in AI?  

e. Name any two real-life applications of AI modeling.  

f. What is the AI Project Cycle?  

g. Name the five stages of the AI Project Cycle.  

h. What is problem scoping in AI?  

i. Why is data collection important in AI projects?  

j. What do you understand by ethical framework in AI? 

Q4. Long Answer Questions: 

a. Explain the concept of AI modeling and its importance in problem-solving.  

b. Describe different types of AI models with suitable examples.  

c. Explain the steps involved in building and training an AI model.  

d. Discuss the role of data in advanced AI modeling.  

e. How do advanced AI models impact industries like healthcare, education, and transportation? 

Q5. Competency-Based Questions: 

a. A school wants to develop an AI system to improve student attendance. Explain how each stage of 

the AI Project Cycle would be used to design this system, and present your idea in a well-structured 

report and write in notebook. 

INFORMATION TECHNOLOGY  

Practical Book Work  

Activity 1 - Create a Two-Page School Newsletter 

Create a file named School_Newsletter.odt and design a two-page newsletter containing: 

 School introduction  

 Recent achievements  

 One table showing examination results  

 At least two images  

 Templates and Styles  

 Footer with page numbers 

Activity 2 - Design a Poster on “Save Environment” 

Create a file named Save_Environment_Poster.odt and design an attractive poster using: 

 A suitable title style  

 At least one image  

 Shapes from the Drawing Toolbar  

 Fontwork for the heading  

 Text wrapping around the image  

 A decorative page border 

Activity 3 - Prepare a Project Report on “Artificial Intelligence in Education” 

Create a file named AI_in_Education.odt and prepare a report of 4–5 pages using: 

 A cover page  

 Heading styles  



 Table of Contents  
 Relevant images  

 Header and Footer  

 Page numbers  
 Track Changes (make at least two edits and show the changes)  

Submission Instructions 

 Complete all three practical activities neatly.  

 Attach printouts and screenshots for each activity.  

 Save all digital files with appropriate names.  

 Submit the Practical book in the first Information Technology lab session after the summer vacation 

Unit 1: Digital Documentation (Advanced) using Libre Office Write 

 

 

Section A: Multiple Choice Questions 

1. Which shortcut key opens the Styles window in LibreOffice Writer? 

a) F5    b) F7    c) F11    d) F12 

2. Which style is used to format an entire page? 

a) Paragraph Style  b) Character Style  c) Page Style   d) List Style 

3. Which style is used to format selected text only? 

a) Character Style  b) Frame Style  c) Table Style   d) Page Style 

4. Which option is used to apply a style to multiple locations in a document? 

a) Auto Format  b) Fill Format   c) Clone Format  d) Copy Style 

5. Which option is used to insert an image? 

a) Tools → Image  b) Insert → Image  c) Format → Picture  d) Edit → Insert 

6. Which tool removes unwanted portions of an image? 

a) Rotate   b) Crop   c) Resize   d) Group 

7. Which toolbar is used to create flowcharts and shapes? 

a) Standard Toolbar  b) Drawing Toolbar  c) Image Toolbar  d) Table Toolbar 

8. Which feature automatically creates a list of headings and page numbers? 

a) Header   b) Table of Contents  c) Footer   d) Bookmark 

9. Which feature records changes made by different users? 

a) Spell Check  b) Track Changes  c) AutoCorrect  d) Mail Merge 

10. Which file extension is used for LibreOffice Writer documents? 

a) .docx   b) .txt    c) .odt    d) .ppt 

11. Which style category is used to format tables? 

a) Table Style   b) Page Style   c) Frame Style  d) Character Style 

12. Which option stores only the image reference and reduces file size? 

a) Embed   b) Link   c) Crop   d) Compress 

13. Which style category is used for numbering and bullets? 

a) Character Style  b) List Style   c) Frame Style  d) Table Style 

14. Which key is used to exit Fill Format mode? 

a) Enter   b) Shift   c) Esc    d) Tab 

15. Which style category is used to format containers that hold text and graphics? 

a) Frame Style  b) Character Style  c) List Style   d) Table Style 

16. Which option combines multiple objects into one? 

a) Merge   b) Join   c) Group   d) Align 

17. Which feature helps create documents with a pre-designed format? 

a) Templates   b) Macros   c) Filters   d) Scenarios 



18. Which menu contains the Drawing Toolbar option? 

a) Edit    b) View   c) Format   d) Tools 

19. Which option is used to rotate an image? 

a) Rotate   b) Filter   c) Transparency  d) Anchor 

20. Which style is applied by default to a new document? 

a) Heading 1   b) Default Style  c) Text Body   d) Custom Style 

Section B: Short Answer Questions (Answer in 30–50 Words) 

1. What is a Style in LibreOffice Writer? 

2. Name the six categories of Styles. 

3. What is the purpose of Fill Format? 

4. Differentiate between Cropping and Resizing. 

5. What is the use of Templates? 

6. Explain the Track Changes feature. 

7. What is a Table of Contents? 

8. What is the benefit of linking an image? 

9. How can you group drawing objects? 

10. Write the steps to insert an image in Writer. 

Section C: Case Study Based Questions 

Case Study 1: School Magazine 

Riya is preparing a school magazine in LibreOffice Writer. She wants all chapter headings to have the same 

font, size, and color. She also wants to insert photographs and automatically generate a Table of Contents. 

Questions: 

1. Which feature should Riya use to format all headings consistently? 

2. Which style is most suitable for headings? 

3. Which menu is used to insert images? 

4. Which feature will generate the Table of Contents automatically? 

 

Case Study 2: Family Tree Project 

Arjun is creating a family tree using rectangles, arrows, and text boxes. After completing the design, he 

wants to move the entire diagram as one object and change the color of all shapes together. 

Questions: 

1. Which toolbar should Arjun use to create the diagram? 

2. Which feature will combine all objects into one? 

3. Which toolbar allows changing fill and line colors? 

4. What is the benefit of grouping objects? 

Case Study 3: Collaborative Editing 

Three students are working on the same project report. The teacher wants to identify who made each change 

and accept or reject them later. 

Questions: 

1. Which feature should be enabled? 



2. What is the advantage of this feature? 

3. Can changes be accepted or rejected later? 

4. In which type of documents is this feature especially useful? 

Note: Complete this in your IT notebook as part of your holiday homework. 

ART AND CRAFT 

➤ Prepare a neat and well-maintained Art File from PT-I syllabus. 

➤ Complete the still life composition “Pots and Kettle” using pencil shading techniques. 

➤ Draw and colour the compositions “Kettles, Apples and Wine” and “Flowers” neatly in the Art File. 

➤ Complete the compositions “Fruits” and “Vegetables” with proper colouring and finishing. 

 


